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TS REPORTSERVER

TS ReportServer takes output from Report-1V on the host and presents it graphically at the
workstation. It is fully integrated with VIP but does not require that the graphical presentation be
installed or enabled, meaning it will also work when running your application in character mode.
You can also use TS ReportServer with Gateway for Windows.
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PATH DEFINITIONS AND CONVENTIONS

The paths noted in this manual vary depending upon the operating system.
vip-data-path is used to indicate the path where files requiring read and write access are located.

e On Windows 10/Windows 11/Windows Server 2016/Windows Server 2019/Windows Server 2022 the
required path is C:\ProgramData\Thoroughbred Software\TSI.

vip-user-path is used to indicate the path where user specific files requiring read and write access are
located.

e  On Windows 10/Windows 11/Windows Server 2016/Windows Server 2019/Windows Server 2022 the
required path is C:\Users\tbred2\AppData\Roaming\Thoroughbred Software.

vip-program-path is used to indicate the path where executable and some dll files are located.
e  On all Window platforms the default path is C:\Program Files\TSI\Bin.

vip-system-path is used to indicate the path where Thoroughbred ini files and other system files that
require write access are located.

e  On Windows 10/Windows 11/Windows Server 2016/Windows Server 2019/Windows Server 2022 the
required path is C:\ProgramData\Thoroughbred Software.

e  On other Window platforms this path may vary, typically it is C:\Documents and Settings\All
Users\Application Data\Thoroughbred Software.

2

Copyright 2024 Thoroughbred Software International, Inc.



SETUP

The Thoroughbred Environment includes the RPSERYV printer table. From the System
Administration menu select Printer Assignment. For more information see the Dictionary-IV
Administrator Guide. Assign any printer device (i.e. RS, LP, P1) to the RPSERYV printer table.
The recommended printer device is RS. You will then need to modify your IPLINPUT file to
include this printer device.

For more information see the Thoroughbred Basic Customization and Tuning Guide.

IPLINPUT for Windows Basic:

DEV RS,4,,,,,,NUL
or
DEV RS,4,,,,,,file-name

Where file-name is the name of any text file defined in your Thoroughbred Basic Environment
for example, basic-install-path\Tbsc\RSText.txt

IPLINPUT for UNIX:

DEV RS,4,,,1,,,/dev/null
For more help on how to use the TS ReportServer
e Select vip-data-path\Tsi\Bin\Rps.hlp, or
e Select Help and then select Help Index from the TS ReportServer menu bar.
For more information see the Thoroughbred Basic Customization and Tuning Guide.
Creating and Sending Report-IV Output to TS ReportServer

TS ReportServer is included as a standard output device in the Dictionary-IV printer selection
prompt:

ISElect Printer ( LP PAL B3 PF PN ) :IRS I

When TS ReportServer is selected as the output device, the report will automatically be
displayed by the TS ReportServer on the client.
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& Thoroughbred RPS Server - Samplel.rps - |E||1|

File Edit View Options ‘Window Help

=\ d| & 52| aln

=101 x|
OE-RCUST Sample System - Customer Listing Page: 1
09/20/96 B9:40 A —
Cust

Code --- Contact ——- ——--—-- Mame ----- ----—- City ---- St SR - Sales —-
188188 Tex Rogers Toot-Your-Horn Port Lavaca TR AF 15,827 .68
180181 David Kelly Fix-H-Up Seadrift TH HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ 16,628 .04
108183 Robert Brock Today's Gompany Bridgewater NJ JS  16,951.04
188184 Sarah Smith ACME Inc. Dayton HJ AF 17,222.36
1008105 Walter Snider Lumber Inc. Big Horn HD HP 17,442 .88
180186 Dennis Gohlke 0K Development Port Lavaca T8 JJ 17,689.96
180187 John Dworaczyk  Hemory Lanes Uictoria TZ JS  18,318.16
222221 TEHWP CUSTA TEMP CUSTH Port Lavaca T 21 13,759.88
2227222 TEMP CUST2 TEMP CUST2 Port Lavaca Td 22 13,226.85
22272 TEWP CUSTA TEMP CUSTA Port Lavaca T JJd 15,135.78
222222 Deleted custs Deleted custs 22 -80

14

|<|<| Page 1 | >|>|||

Ready |Page 1 [ um ]

TS ReportServer can display multiple reports. Each report is displayed in a window contained by
one common TS ReportServer GUI Server window.

&8 Thoroughbred RPS Server - Sampled.rps = |E||1|

File Edit ‘iew Options ‘Window Help
SN

#F¥'samples.rps
0E
oo ?;Sample-{.rps
OE
Lkt

I DE-RINUH Sample System — Invoice Header Page: 1 =
== A2/28/96 89:49 AM
18
18 Invoice ——--——- Company Hame------ —- Date—— ——- Amount--- --— Credits-- --Payments—-
18
18 6088081 Toot-Your-Horn 81/12/96 241,93 .aa .aa
28 a8eae2 Fix-M-Up 81/13/96 L70.82 .88 ]
28 808883 Computer Inc. 81/14/96 684.38 .88 .88
28 8080884 Today's Company 81/15/96 884 77 .88 .88
28 8060885 ACHE Inc. 81716796 10871.39 .88 .88
38 a0@@8a6 Lumber Inc. 81/17/96 1244 19 -8B -8
30 g08887 0K Development 81/18/96 1483.18 .88 ]
38 608888 Memory Lanes 81/19/96 1548.33 .88 ]
38 aae8a¢ TEWP CUSTH 81/28/96 2208 .45 .88 .88 _|
]3 8066818 TEWP CUsST2 81/21/96 2246 47 .88 .88
8066811 TEWP CUSTA 81722796 269919 .88 .88
808812 Toot-Your-Horn 81/23/96 2903.13 .aa -
7R masne sme  mmee an pysy

|<|<| Page 1 | >|>|||

Ready [Page 1 [ [mom 4

Any report displayed by TS ReportServer can be saved locally on the client. By default, the file
is saved in TS ReportServer format (with the .rpt file extension). For more information on saving
and opening local report files please see "Save a Report" later in this manual.
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An application performing CONNECT REPORT can control the output device by pre-setting the
printer id. This allows the application to send the report output to the TS ReportServer without
user intervention.

If the TS ReportServer is available, Query-1V sends all terminal output to the TS ReportServer
for processing. Your application can duplicate this process. Query-IV uses the following tests to
determine if the TS ReportServer is available:

Is the default output set to the terminal?
FID(0)
Does the Global variable RPSERYV exist?

CGV ("RPSERV")

Does the Workstation have GUI capabilities?

#IDVIP.GUI-ON="Y"

If these tests determine that the TS ReportServer is available set the output device to the Global
variable RPSERYV.

LET REPORTS [6]=cgv ("RPSERV")

CONNECT Report "report-name"
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TS REPORTSERVER WINDOW

The main TS ReportServer GUI Server window is displayed when TS ReportServer is selected
as the output device on the host or when you select the TS ReportServer icon on the client from
the VIP program group.

& Thoroughbred RPS Server =1olx|

File Options  Help

== | 2| 2] o]

|<|<| Fage 1 | >|>I||
Ready |Page 1 [ [ s
File
Open an rps file

Print Setup to select the printer properties, etc.

Print Setup 20|

— Frinter
MName: Apple Lazerw/iter || NT Froperties. .. |
Status: Ready
Type: Aipple Lazerw/iter || NT w47.0
“Where:  LPTI:
Comment:

— Paper Orientation
Size: ILetter j &+ Puortrait
Source; |Automalically Select j " Landscape
Metwark. . | oK I Cancel |

Recent Files to select from the last files opened.

Exit TS ReportServer.
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Options

Check (display) or uncheck (remove) the Status Bar, Pagebar, and Toolbar from the TS
ReportServer window. See the graphic above to see where these are located.

Check Paged Scroll to scroll the last 100 pages of the report history.

Help
Access TS ReportServer help.

Open a Report

From the TS ReportServer window select the File menu and then select Open.

open x|

Lok ir I ) Reports j - I'j‘ -

Samplel.rps
SampleZ.rps
Sample3.rps
Sampled.rps
Samples.rps

File: name: | Open |
Files of bype: IThomughbled Repoits [*rps) j Cancel |
v

NOTE: TS ReportServer can only open (display) files that have been saved in .rps format.
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The .rps files above are sample reports that are stored in vip-user-path\TSI\Reports. Select
Samplel.rps and the following report appears:
=lolx|

File Edit View Options ‘Window Help

=\ d| & 52| aln

OE-RCUST Sample System - Customer Listing Page: <
09/20/96 B9:40 A —
Cust

Code --- Contact ——- ——--—-- Mame ----- ----—- City ---- St SR - Sales —-
188188 Tex Rogers Toot-Your-Horn Port Lavaca TR AF 15,827 .68
180181 David Kelly Fix-H-Up Seadrift TH HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ 16,628 .04
108183 Robert Brock Today's Gompany Bridgewater NJ JS  16,951.04
188184 Sarah Smith ACME Inc. Dayton HJ AF 17,222.36
1008105 Walter Snider Lumber Inc. Big Horn HD HP 17,442 .88
180186 Dennis Gohlke 0K Development Port Lavaca T8 JJ 17,689.96
180187 John Dworaczyk  Hemory Lanes Uictoria TZ JS  18,318.16
222221 TEHWP CUSTA TEMP CUSTH Port Lavaca T 21 13,759.88
2227222 TEMP CUST2 TEMP CUST2 Port Lavaca Td 22 13,226.85
22272 TEWP CUSTA TEMP CUSTA Port Lavaca T JJd 15,135.78
222222 Deleted custs Deleted custs 22 -80

14

|<|<| Page 1 | >|>|||

Ready |Page 1 [ um ]

NOTE: The TS ReportServer can handle multiple reports as well as split screen viewing within a
report. See below.

Menus
File
Open an .rps file located in vip-user-path\TSI\Reports.
Close the currently highlighted report.
Save the currently highlighted report.
Save As an .rps or .txt file.
Print the currently highlighted report.
Print Preview of the report before printing.

Print Setup
Displays the dialog box below so you can select the printer, paper size, orientation, etc.
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rintsetun x|

— Printer
Marme: Apple Laseradfiter [| MT Properties... |
Status: Ready
Type: Apple Laserwiiter [ HT «47.0
“Where:  LPTH:
Cormmett:
— Paper Orientation
Size: ILetter = " Partrait
Source: IAutomaticalIy Select j " Landscape

Metwork. .. | oK I Cancel

Recent Files displayed are listed.
Exit TS ReportServer
Edit - Select Copy, Find or Select All
View — Select Zoom In, Zoom Out, or select the Font.

Options — Select to view any or all of the following: Toolbar, Pagebar, Status Bar or Paged
Scroll.

Window — Select to Cascade or Tile the windows. You can also Arrange Icons. This simply
means that when you minimize a report window, an icon for the report displays at the bottom of
the window (see below).

-0l x|

File Edit ‘iew Options ‘Window Help

=[] B 52| ol

5100 sioix]

|<|<| Page 1 | >|>|||

Ready Page 1 [ [mom 4
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and you move one of the "icons" (see below).

& Thoroughbred RPS Server - SampleS.rps = IEIIiI

File Edt “iew Options ‘window Help

=B B S(2| alal

[ a0

T
<] <] Pager | o]
Ready |Page 1 [ o [ s

Select Windows—> Arrange Icons to place them back at the bottom of the screen (see below).

&8 Thoroughbred RPS Server - SampleS.rps = |E||1|

File Edit ‘iew Options ‘Window Help

=[] B2 52| ol

EEmr siojx| R 5o

|<|<| Page 1 | >|>|||

Ready Page 1 [ [mom 4

Help — Select the Help index or find the version number (About).
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Toolbar

The Toolbar can be moved using normal Windows procedures. The following buttons are
available from the Toolbar:

E’l El Open and Save

Open — This button allows you to open an .rps file to edit.

Save — This button allows you to save the file (the first time opened) or to save edits to the
report.

NOTE: From the File menu you can save the report as *.rps, or *.txt files. From the Edit menu
you can copy the report to the clipboard, make changes to the report and save, or exit without
saving. For more information see Saving a Report.

Copy

Copy — This button allows you to copy the edited file to the clipboard.

%l I:E |Print and About

Print — This button allows you to print the edited file.

About — This button displays the TS ReportServer version.

| dh | Font Size and Find

Font Size — This button allows you to zoom in or out in the report.
Find — This button allows you to search the file for characters, numbers, or words.
Split Screen Viewing

With TS ReportServer you can split reports both vertically and horizontally. Each pane contains
a set of scroll bars allowing each to be scrolled independently of the other. It supports a total of
four panes: two vertical split panes and two horizontal split panes.
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=
File Edit View Options ‘Window Help
EEEERE)
=101 x|
OE-RCUST Sample System - Customer Listing Page: 1
09/20/96 B9:40 A —
Cust
Code --- Gontact -—— -——-———- Nameg ---—-—- -———- City -———- St SR —— Sales —-
188188 Tex Rogers Toot-Your-Horn Port Lavaca TR AF 15,827 .68
180181 David Kelly Fix-H-Up Seadrift TH HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ 16,628 .04
108183 Robert Brock Today's Gompany Bridgewater NJ JS  16,951.04
188184 Sarah Smith ACME Inc. Dayton HJ AF 17,222.36
1008105 Walter Snider Lumber Inc. Big Horn HD HP 17,442 .88
180186 Dennis Gohlke 0K Development Port Lavaca T8 JJ 17,689.96
180187 John Dworaczyk  Hemory Lanes Uictoria TZ JS  18,318.16
222221 TEHWP CUSTA TEMP CUSTH Port Lavaca T 21 13,759.88
2227222 TEMP CUST2 TEMP CUST2 Port Lavaca Td 22 13,226.85
22272 TEWP CUSTA TEMP CUSTA Port Lavaca T JJd 15,135.78
222222 Deleted custs Deleted custs 22 -80
178,366.35
-
Kl | 4
|<|<| Page 1 | >|>|||
REady Page 1 lilmli v

Grab for horizontally
split screen.

To create two vertical panes
Grab the little button on top of the vertical scroll bar (see graphic above) and then drag your

mouse down.

& Thoroughbred RPS Server - Samplel.rps

File  Edit

Wigw  Options  window  Help

=18l

EEEEREC

REE
|ﬂ CUST Sample System - Customer Listing Page: 1«
09/20/96 ag:42 AM

Cust

Code --- Gontact -—— -——-———- Hame ---—- -———- City --——- St SR -- Sales —-
108188 Tex Rogers Toot-Your-Horn Port Lavaca TX AF 15,827 .88
188181 David Kelly Fix-W-Up Seadrift TA HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ JJd 16,628.84
188183 Robert Brock Today's Company Bridgevater HJ J5 16,951,084
180184 Sarah Smith ACHME Inc. Dayton HJ AF 17,222.36
188185 Walter Snider Lumber Inc. Bigq Horn HD HP 17,442 _ 060 ‘:J
OE-RCUST Sample System - Customer Listing Page: 1 =
09/20/96 82:42 AM

Cust

Code --- Contact ——— -——————- Hame ----- ----- city ---- St SR -—— Sales —-
188188 Tex Rogers Toot-Your-Horn Port Lavaca TX AF 15,827 .88
188181 David Kelly Fix-H-Up Seadrift TH HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ 16,628.04
188183 Robert Brock Today's Company Bridgeuwater HJ JS 16,051.04
188184 Sarah Smith ACME Inc. Dayton NJ AF 17,222.36
1808185 Walter Snider Lumber Inc. Big Horn HD HP 17,442 .88
180186 Dennis Gohlke 0K Development Port Lavaca T JJd 17,689.96 -

LLEN ] lnbhe Paonsaaa—eals (TEN P BENEAE M ndnead TU e AR AR Ar

it i~ uf
|<|<| Page 1 | >|>I||
Ready |Page 1 I_WI_ 4
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You now have two vertical panes that can be scrolled independently. To create a single pane,
reverse the procedure used to create two panes.

To create two horizontal panes
Grab the little button on the left of the horizontal scroll bar (see graphic at the beginning of this
section) and then drag your mouse to the right.

& Thoroughbred RPS Server - Samplel.rps = IEIIiI

File Edt “iew Options ‘window Help

EEIEEEET

-oix|
|ﬂE—REUST Sample System |ﬂE—REHST Sample System - Cus_
09/20/96 89/20/96 —
Cust Cust
Code --- Gontact -—— -——-———- Hame | Code --- Contact -— -—————— Hame ---
180188 Tex Rogers Toot-Your-Ho [188188 Tex Rogers Toot-Your-Horn
100181 David Kelly Fix-HM-Up 180161 David Kelly Fix-M-Up
188182 Sue Thompson Computer Inc (188182 Sue Thompson Computer Inc.
188183 Robert Brock Today's Comp (188183 Robert Brock Today's Company
180184 Sarah Smith ACHME Inc. 188184 Sarah Smith ACHME Inc.

100165 UWalter Snider Lumber Inc. [188185 UWalter Snider Lumber Inc.
10081806 Dennis Gohlke 0K Developme (168186 Dennis Gohlke DK Development
188187 John Dworaczyk Hemory Lanes (188187 John Dworaczyk Hemory Lanes
222221 TEHWP CUSTAH TEHP CUSTH 222221 TEHWP CUSTAH TEHP CUSTH
222222 TEHWP CUST2 TEHP CUST2 222222 TEHWP CUST2 TEHP CUST2
22222 TEKWP CUSTA TEHP CUSTA 222220 TEMP CUSTA TEHP CUSTA
222227 Deleted custs Deleted cust (227277 Deleted custs Deleted custs

N — Ja | KOl | o 4
<] <] Pager | o]
Ready |Page 1 [ o [ s

You now have two horizontal panes that can be scrolled independently. To create a single pane,
reverse the procedure used to create two panes.
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To create four panes
Simply perform the two procedures above and you will have a split screen similar to the one
below:

& Thoroughbred RPS Server - Samplel.rps = IEIIiI

File Edt “iew Options ‘window Help

=B B S(2| alal

=10| x|
PE*RCUST Sample SysteluE*RCUST Sample System - Cust o
09/20/96 09/20/96

Cust Cust

Code --- Contact ——— -————-—- Na| Code --- Contact -—— -—--——-- Name ---—-—-
188188 Tex Rogers Toot-Your- 188188 Tex Rogers Toot-Your-Horn
180181 David Kelly Fix-M-Up [188181 Dawvid Kelly Fix-H-Up

188182 Sue Thompson Computer I 188182 Sue Thompson Computer Inc.

188183 Robert Brock Today's Co 188183 Robert Brock Today's Company
188184 Sarah Smith ACME Inc. [188184 Sarah Smith ACHE Inc. ‘:J
DE-RCUST sample Syste [IE-RCUST Sample System — Cust a
09/20/96 09/20/96

Cust Cust

Code --- Contact ——— -——-———- Na| Code --=- Contact ——— --—-———- Name -----
188188 Tex Rogers Toot-Your- (188180 Tex Rogers Toot-Your-Horn
180181 David Kelly Fix-M-Up [188181 David Kelly Fix-H-Up

188182 Sue Thompson Computer I [|188182 Sue Thompson Computer Inc.

188183 Robert Brock Today's Co 188183 Robert Brock Today's Company
180164 Sarah Smith ACME Inc. [186104 Sarah Smith ACHE Inc. =
_‘]n_n, e P o 'ﬂ i S B -

I<| <|  Page |>|>|||

Eeah) [Page 1 [ oM )

The frame can be resized using normal Windows procedure. Grab any side or corner and enlarge
or decrease the size.
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Save a Report

A report can be saved by selecting File menu Save, by closing a report window or by closing the
main TS ReportServer window. The following message is displayed for the top report displayed
in the main TS ReportServer window:

Theroughbred RPS Server - Sample System - Invoice Header (== =]

File Edit View Options Window Help

(e | &(?] a6l

ol

m - Sales Rep Listing
A [ sample System - Invoice Header

5 |c( ~RINVH
B2/08,18

Invoice ----- @ Sawe changes bo Sample Spstem - Irvoice Header?

BEE081 Toot-
BEOEOZ F1ix-M
eea0as Compu

Today
BEEOAS ACME
pEEOAE Lumber Inc. 09/08,/09 1244.19

[41 |

‘e Mo Noboal Cancel I

|<|:I Page 1 | >|;II|

Ready [Page1 I I

Yes — Will save the report prompting for a file name, location, and a file extension.
No — Will close the report without saving it.

No to all — Will close the current report without saving and will not prompt you to save when
closing other report windows. This eliminates the need to respond No for each opened report.

Cancel — Closes the save dialog and without doing anything.
TS ReportServer allows you to save a report in two formats.
Saving as a Thoroughbred Reports file (*.rps)

o From the File menu select Save. The report file will be saved to the default folder. The
default folder location is set from the WorkStation Manager Default Directories tab. If none
is supplied report files will be saved in vip-user-path. For more information, please see the
WorkStation Manager Manual.
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¢ From the File menu select Save As and then you can save the report as a TS ReportServer
file (.rps) in the folder of your choice.

Saving in a different format

From the File menu select Save As and then you can save the report as a text file (txt) in the
folder of your choice.

NOTE: TS ReportServer can only display reports that are saved in .rps format. Once a report is
saved as a text file, TS ReportServer cannot be used to open it.

Copying to the Clipboard

From the Edit menu select Copy and then you can Paste the report in any DDE compliant
application.

16
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GATEWAY FOR WINDOWS

The host program requires a simple communication. Each page uses a single CALL to the
program RPSCOM.

Terminate each line on the page with:

CRLF (CHR(13)+CHR(10))

Terminate each page with:

FF (CHR(12))
page-of-data" + CHR(12)

Prefix the CRLF at the end of each line with a CHR(11) to indicate a heading line.

CHR(11l) + CRLF

The TS ReportServer displays a dialog status box as each page is received and processed.
Append the following instruction to the final page of the report:

"page-of-data-for-last-page"” + "[.END.]"

The TS ReportServer immediately displays the report. It allows complete user manipulation and
processing of the report, including forward and backward scrolling, printing to a file, and saving
to a file.

Example

The following example illustrates the simplicity of the host programming required to invoke TS
ReportServer.

00010 REM &REMé&
00020 BEGIN;

DIM M$[5];
!Gateway call string
LINEENDS$=CHR (13) +CHR (10) , 'End of
line indicator
HEADLINEENDS=CHR (11) +LINEENDS, 'End of heading
indicator
LASTS$="[.END.]" 'Last

page indicator

17
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09000 RUN

00100 M$[1]="1I4",

MS[2]=

"RPS " ,

M$[3]="SYSTEM",
M$[5]="[.LOAD.]";
CALL "RPSCOM",MS$ [ALL] ;

IF M$S[O]<>"."
GOTO 9000
ELSE
M$[1]="P",

width

M$ [5]=H**"+

"UTSAMPLE"+

!'(11,40)=Report Description

"Gateway for Windows Test Report "+

"080"+

"060";

lines/page

00200

00210

00220
00230

00240
00250

CALL "RPSCOM",M$[ALL]

REM PAGEl

p$="",

P$=P$+" HEADING LINE
P$=P$+" HEADING LINE
P$=P$+"DETAIL LINE 1
P$=P$+"DETAIL LINE 2
P$=P$+"DETAIL LINE N
P$=PS$+CHR (12) ;

GOSUB 1000

REM PAGE2 THRU PAGEn

pS="",

P$=P$+" HEADING LINE
P$=P$+" HEADING LINE
P$=P$+"DETAIL LINE 1
P$=P$+"DETAIL LINE 2
P$=P$+"DETAIL LINE N
P$=P$+CHR (12) ;

GOSUB 1000

REM LAST PAGE
P$=" n ,

1 "+HEADLINEENDS,
2 "+HEADLINEENDS,
"+LINEENDS,
"+LINEENDS,
"+LINEENDS,

1 "+HEADLINEENDS,
2 "+HEADLINEENDS,
"+LINEENDS,
"+LINEENDS,
"+LINEENDS,

P$=P$+" HEADING LINE 1 "+HEADLINEENDS,

01000

P$=P$+" HEADING LINE
P$=P$+"DETAIL LINE 1
P$=P$+"DETAIL LINE 2
P$=P$+"DETAIL LINE N
P$=PS$+LASTS;

GOSUB 1000;

GOTO 9000

MS[5]=P$;

2 "+HEADLINEENDS,
"+LINEENDS,
"+LINEENDS,
"+LINEENDS,

CALL "RPSCOM",M$[ALL] ;

RETURN

Mok k1
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'Define Report Message:

!(1’2)=n**n
! (3,8)=Report name

! (51,3)=Report

! (54, 3)=Number of



MULTI-LANGUAGE

For more information about Multi-Language, see the Dialog, Message, and MenuBar Text
Translations section in the Multi-Language for VIP.

19

Copyright 2024 Thoroughbred Software International, Inc.



	TS ReportServer
	Path Definitions and Conventions
	Setup
	Creating and Sending Report-IV Output to TS ReportServer

	TS ReportServer Window
	Open a Report
	Menus
	Toolbar
	Split Screen Viewing

	Save a Report
	Saving as a Thoroughbred Reports file (*.rps)
	Saving in a different format
	Copying to the Clipboard


	Gateway for Windows
	Multi-Language

